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USING THIS MANUAL 
 
 
CH I          INTRODUCTION. Explains what 

the PowisPrinter™ offers. 
CH II          FIRST TIME SETUP.  Illustrates 

how to set up the printer. 
 
 
 
 
CH III         PRINTING A QUICK TITLE. 

Describes how to print a simple 
strip.  

CH IV        KEYBOARD FEATURES. Explains 
the many features and options 
available on the PowisPrinter™ 
keyboard. You’ll use these features 
to create exciting, more elaborate 
Binderstrips™. 

 
 
 
 
 
 
CH V         PRINTING MORE ELABORATE 

TITLES. Walks you step-by-step 
through creating and printing 
deluxe, multi-zone, multi-
orientation Binderstrips™. Neat! 

 
CH VI        THE POWIS PRINTER™ AND 

YOUR COMPUTER. Explains 
how to set up the PowisPrinter™ 
to a computer. 

 
 
CH VII        THE POWIS PRINTER™ AND A 

FASTBACK®  BINDER. Shows 
you how to dock the binder to 
the printer, and print as a docked 
unit to a Fastback® binder for 
immediate binding. 

 
 
CH VIII       PROBLEM SOLVING.  Describes 

what to do if you have problems, 
and how to contact technical 
support. Also provides a list of 
frequently asked questions (and 
their answers). 

 
 
 
 
 
 
 
We encourage you to play with your 
PowisPrinter™. Press buttons, 
experiment with different features, 
print wacky strips, try all the 
possibilities. It’s a fun machine, so 
have a good time!  
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Welcome!  
 
Meet the PowisPrinter™, an extraordinary new printer that lets you 
print directly onto a Binderstrip™. It prints colored text on up to three 
different locations of the strip, in a variety of orientations, and accepts 
different lengths of narrow, medium and wide Binderstrips™. So not 
only can you print on Binderstrips™, but you have complete flexibility 
in how you do it.  
 
Need even more printing options? Windows 95™ compatible software 
is available with the PowisPrinter™ to expand your printing capabilities. 
Once you set up the PowisPrinter™ to your computer, you can use 
any of your computer’s installed fonts, print bitmap images for logos or 
styling, store hundreds of document titles for later retrieval, see the 
entire Binderstrip™ as you design it, and use your computer’s full size 
keyboard.  
 
And there’s more! With a simple service modification to your 
Fastback® binding machine, you can dock the PowisPrinter™ to a 
Fastback® binder, and the two machines work together.  This allows 
the printer to print on the book’s spine immediately before binding.  
Which allows you to print and bind in one easy step. 
 
 So sit back, relax, and get to know your PowisPrinter™.  

NOTE: This equipment has been tested and 
found to comply with the limits for a Class B 
digital device pursuant to Part 15 of the FCC 
rules. These limits are designed to provide 
reasonable protection against harmful 
interference when the equipment is operated 
in a commercial environment. This equipment 
generates, uses, and can radiate radio 
frequency energy and, if not installed and used 
in accordance with the instruction manual, 
may cause harmful interference to radio 
communications. Operation of this equipment 
in a residential area is likely to cause harmful 
interference in which case the user will be 
required to correct the interference at his 
own expense. If this equipment does cause 
harmful interference to radio or television 
reception, which can be determined by turning 
the equipment off and on, the user is 
encouraged to try to correct the interference 
by one or more of the following actions: 
 
•      Reorient or relocate the receiving 

antenna 
•      Increase the separation between the 

equipment and the receiver 
•      Connect the equipment into an outlet 

on a different circuit from that to which 
the receiver is connected. 

 
CAUTION:  Changes or modifications to the 
PowisPrinter™  not expressly approved by 
Powis Parker Inc. could void the user’s 
authority to operate this machine. 

Internal parts can be extremely    
hot!  Do not attempt to open the  
machine unless you have read this  
manual.  Follow all precautions.  

A             Front Door 
B              Power ON Light  
C             Top Hatch 
D             Input Ports (2) 
E              PowisPrinter™ Sensor 
F              Binder Exit 
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I               Binderstrip™ Feed Entry 
J               Binderstrip™ Feed Exit 
K             Power ON Switch 
L              Power Cord Receptacle 
M             Fuse Holder 
N             Voltage Setting 

A             Text Orientations:  Landscape, Stacked, Portrait  
B              Text Zones:  Top, Middle, Bottom 
C             Help Key 
D             Backspace Key 
E              Escape, Clear, Menu, Eject Keys 
F              Print, Bind Only, Print & Bind, Repeat Keys 
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You can use your PowisPrinter™ alone... 

Or docked to a Fastback® Model 11 or Model 15. 
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F I R S T  T I M E  S E T U P  II 

F I R S T  T I M E  S E T U P  

A.  What’s Included 
 
      Your PowisPrinter™ and accessories are shipped in a single box.  

This includes: 
 
      •     The fantastic PowisPrinter™ 
      •     Keyboard and Cable 
      •     User’s Manual 
      •     Power Cord 
      •     Two Foil Cartridges — one gold and one silver 
      •     Software Package (compatible with Windows 95™) 
      •     Printer to PC cable 
      •     Keyboard Foot 
 
 
B.   Unpacking 
 
1.    Remove and unpack the Accessory Pack from the cradle (figure 6).  
2.    Lift out the printer cradle from its carton (figure 7). 
3.    On a stable surface, drop the sides of the cradle and take out the 

printer (figure 8). 
4.    Position the machine on the desk, table, or counter where it will 

reside.  Place the 6" long purple cylinder onto the keyboard’s foot 
(Figure 9). 

 
 
C.  Plugging In 
 
1.    Plug the keyboard cable into the bottom Input Port (figure 1).  
2.    The Power Switch is located at the lower left on the back of the 

machine (figure 2).  Check to see that the Power Switch is “Off” by 
depressing the “O” side of the Power Switch.  

3.    Plug the Power Cord into the outlet on the back of the machine.  
Then connect the Power Cord to a standard, grounded electrical 
outlet. 

 
 
D.  Loading a Foil Cartridge 
 
1.    Open the Front Door. Notice the illustration for loading a foil 

cartridge on the inside of the door. 
2.    Take out one of your foil cartridges. Remove the orange shipping 

tab. 
3.    Look at your foil cartridge. Does the foil balloon out? If it does, 

turn the purple wheel on the cartridge clockwise, so the foil 
tightens up. The foil should have no slack.  

4.    Now squat down and look in the machine. Carefully insert the 
cartridge over the printhead (figure 10). The foil should slide in the 
gap between the drum and the printhead. Listen for a click that 
tells you the cartridge is snugly in place.  

5.    Close the Front Door. 

5 
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P R I N T I N G  A  Q U I C K  T I T L E  

1.    Turn the Power Switch “ON”.  The Power Switch is located at 
the lower left on the back of the machine (figure 2).  The green 
Power ON light on the front of the machine will blink. 

 
       The keyboard display will show “Printer self-test.”  When the 

warm-up cycle is completed, the green Power ON light will 
remain on, and the display will show: 

 
 
 

       This screen is called the Text Screen. 
 
2.    Type a few words — for example, “hot dog.”  
3.    Press PRINT. 
4.    The screen prompts you for a book width. Type “s.”  Then type 

“35” (as though you have 35 sheets of paper). 
5.    Press ENTER. 
6.    Insert a narrow strip into the Binderstrip™ Feed Entry (figure 

1), adhesive side up. 
7.    The printer will now print the Binderstrip™, and eject it from 

the Feed Exit.  
 
       And that’s all there is to it — you just printed your first 

Superstrip™. Feels good, doesn’t it?  

[■] 
[  ] 
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             Orientation Keys 
A           Landscape             
B           Stacked   
C           Portrait                 
 
 
             Zone Keys 
D           Top        
E            Middle     
F            Bottom 

A.   Orientation and Zone Keys 
       The orientation and zone keys help you create original and 

interesting Binderstrip™ titles. By using these keys, you can print 
text across, up and down, sideways, in the middle, at the bottom, at 
the top, in all areas of the strip!  The orientation and zone keys are 
located in the bottom left corner of the keyboard, on and above 
the book image (Figure 3).  

 
 
       Zone Keys: Placing Your Text 
 
       The zone keys are located on the spine of the book image (Figure 

11).  They represent the different “zones” of a book’s spine — the 
top zone, middle zone, and bottom zone. When you want to put 
text in a certain zone, just press the corresponding key. For 
example, if you want your text in the middle of the Binderstrip™ , 
press the Middle Zone key. Or if you want text at the top, press the 
Top Zone key. It’s that easy.  And remember, you can put text in 
one zone, two zones, or even all three zones of one Binderstrip™.  

 
 
       Orientation Keys: Setting Up the Direction of Your Text 
 
       Within each zone, you have to decide how to orient your text. 

That’s where the orientation keys come in. The orientation keys are 
the three small round buttons labeled with ABCs, located above the 
book image. They orient the text in three different ways: Landscape, 
Stacked, or Portrait.  

7 

Hints:  
•     Stacked orientation permits only one line of 

text per zone. 
•     If you have a lot of text to print, try 

Landscape. 
•     Portrait orientation usually has room for 

only a few characters.   
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B.   The MENU Key 
 
      The MENU key is full of useful features. Within MENU, you can 

change the font type, size, and style; save titles; recall previously 
saved titles; access logo menus; and adjust the contrast and text 
offset. And you can work with any of these features at any point 
while designing your strip. 

 
    To select a menu item, press the MENU key (figure 12) and use 

the arrow keys to scroll through the menu.  Press the number of 
the option you want.  You can press ESC at any time to go back to 
the Text Screen. 

 
1.    SELECT FONT 
 
      Select Font allows you to change the font. You have eleven 

wonderful font choices:   

 1.Times  2.Bodoni  3.Palatino    � 
 4.Univers   5.Univers Condensed   � 

•    To view more fonts, press �: 

•    To view more fonts, press �: 

•    Once you have chosen a font, select an option to change all of the 
zones or just one of them: 

      If you just press ENTER, the printer changes the font only in the 
zone you are currently in.  After making your selection, the printer 
confirms your font change in the zone(s) you have selected. 

� 6. Avant Garde 7.Clarendon Condensed � 
� 8.Gill Sans Condensed  9.Helvetica   � 

� A.Microstyle  B.Zapf Chancery 

Select which zone will be affected 
1.ALL 2.TOP 3.MIDDLE     4.BOTTOM 

8 

•    Press the MENU key, and then press the (1) key (SELECT FONT). 
•    Make a selection from the font options by pressing a number:  
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2.    FONT SIZE 
 
      If you want to make your text bigger or smaller, this is the option to use. 

You can adjust the size from 8 to 84 points, or you can instruct the 
printer to AutoFit your title on the strip. AutoFit will automatically 
calculate the largest font to fit in the space provided.  Sample font sizes: 

8 POINT SAMPLE TEXT 

 
12 POINT SAMPLE TEXT 

 

16 POINT SAMPLE TEXT 

36 POINT SAMPLE TEXT 

48 POINT SAMPLE TEXT 

60 POINT SAMPLE TEXT 
•     Press the MENU key, and then press the (2) key (FONT 

SIZE).  You will see: 

•     Enter the point size. Press ENTER to finish. 
•     Select an option to change all of the zones or just one of 

them. 

       If you just press ENTER, the printer changes the font size 
only in the zone you are currently in. 

 
3.    FONT STYLE 
 
       Font Style lets you format the font style. You have four 

styles to select from:   
 
       NORMAL SAMPLE TEXT 
       BOLD SAMPLE TEXT 
       ITALIC SAMPLE TEXT 
       BOLD-ITALIC SAMPLE TEXT 

Enter point size (8-96):  AUTOFIT 
or Press "A" for AUTOFIT 

Select which zone will be affected 
1.ALL 2.TOP 3.MIDDLE    4.BOTTOM 
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•     Press the MENU key, and then press the (3) key (FONT STYLE).  Make 
a selection from the printer’s font style options by pressing a number: 

•     Select an option to change all of the zones or just one of them. 

Please choose font style: 
1. Normal 2. Bold 3. Italic 4. Bold-Italic 

       Keep in mind that not all styles are available for all fonts.  For example, 
Microstyle is available only in normal and bold styles.  If you try to apply 
a style that is not available for a certain font, the printer will let you 
know on the confirmation screen: 

Select which zone will be affected 
1.ALL 2.TOP 3.MIDDLE    4.BOTTOM 

4.    DEFAULT FORMATS 
 
       You can reset all of the zone’s fonts, font sizes, and font styles to the 

preset defaults.  (The factory preset defaults are Univers Condensed, 
AutoFit, and Normal, but you may change these defaults in User 
Settings, MENU option 11.)  

 
•     Press the MENU key, and then press the (4) key (DEFAULT 

FORMATS).   You will see: 

Top  Zone:  Font:  Microstyle 
Style not available.  Style not changed. 

•     Press Y to set all zones to the preset defaults, N to cancel. 
 
 
 
 
 
5.    STORE TITLE 
 
       You can store up to eight titles for future recall in the printer’s memory.  

When you store a title, the printer will save the title exactly as you 
designed it—it remembers your text; the orientation of each zone; and 
the font and style you applied.  Groovy!   

 
•     If you are not already in the Text Screen, press ESC until it appears, and 

you see the title you’ve created. 
 
•     Press the MENU key, the right arrow key once, and the (5) key 

(STORE TITLE).  You will see: 

Reset all zone formats to defaults? (Y or N) 
 (Univers Condensed, Autofit, Normal) 
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      If the memory space is empty, the screen displays “EMPTY” next 
to the location’s number.  Alternately, if you have already saved a 
title here, it displays that title’s middle zone text.   

 
•    Press the right arrow key to scroll through the eight memory  
      locations.  You may save your title in any of these locations.   
•    When you find the memory location where you would like to save 

your title,  press ENTER.  The screen displays: 

•    Press Y to save the title; N to cancel.   
 
      If you press Y, the display flashes a quick confirmation before 

returning to the Text Screen. 
 
6.    RECALL TITLE 
 
      Here you can recall titles that you have previously stored in the 

printer’s memory. 
 
•    Press the MENU key, the right arrow key once, and the (6) key 

(RECALL TITLE).  You see: 

Replace old title in memory?  (Y/N) 
      1:  “EMPTY” 

•    Use the right and left arrow keys to scroll through the stored titles. 
•    Press ENTER when you find the title you wish to recall. 
 
      The printer now returns to the Text Screen, displaying the title you 

have recalled. 
 
 
7.    REVIEW TITLE 
 
      Review Title is a handy feature that allows you to see what you’ve 

written in all three zones. It also gives you a chance to review all 
the font styles you’ve chosen.  

 
•    After you enter or recall a title, press the MENU key, the right 

arrow key once, and the (7) key (REVIEW TITLE). 
•    The Top Zone’s text will be displayed for a few seconds, then the 

Middle Zone’s text, then the Bottom Zone’s text.  The orientation, 
font type, font size, and font style will also be shown for each zone. 

 
 
8.    LOGO MENU 
      (Not available at this time) 

ENTER to save this title.    More > 
      1:  “EMPTY” 

ENTER to recall this title.    More > 
1:  “EMPTY” 
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9.    CONTRAST ADJUST 
 
      Contrast Adjust allows you to adjust the darkness of the display 

screen text.  
 
•    Press the MENU key, the right arrow key twice, and “C” for  
      CONTRAST ADJUST. 
•    Use the up and down arrow keys to adjust the display contrast. If 

you want lighter text, use the up arrow key; if you want darker 
text, use the down arrow key.   

•    Press ENTER when the text reaches the desired contrast. 
 
 
10.  TEXT OFFSET 
 
      Text Offset allows you to shift the text above or below the center 

of the Binderstrip™. 
 
•    Press the MENU key once, the right arrow key twice, and “T” for 

TEXT OFFSET. 
•    Use the + and – keys to shift the text high or low. You can shift 

the  text up to +0.25 in (+6.3 mm), or down to –0.25 in (–6.3 
mm).   

•    Press ENTER when you finish modifying the offset. 
 
 
11.  USER SETTINGS 
 
      The User Settings allows you to choose the keyboard display 

language, set the default thickness units, change the landscape text 
orientation, and set the default font and font style.  To access these 
features,  press the MENU key once, the right arrow key twice, 
and “U” for USER SETTINGS.  

 
 
Choosing the Keyboard Display Language 
 
•    To change the language, press 1 at the User Settings screen.  You 

see: 
 
 
 
 
•    Press the right arrow key to view more languages.  
 
 
 
 
•    Select a language by pressing the corresponding number.   
•    Once you have made your choice, press ENTER.   
•    To activate your language choice and return to the main MENU, 

press ESC.  
 
      The keyboard text now appears in your selected language. 

1.English   2.Spanish     3.German � 
4.French      5.Italian   6.Dutch  � 

� 7.Swedish        8.Danish    9.Norwegian 
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      Setting the Default Thickness Units 
 
      You can program the PowisPrinter™ to always use your preferred 

measurement unit.  
 
•    To do so, simply press 2 at the User Settings screen.  You see: 

•    Select a thickness unit by pressing the corresponding number. 
•    Once you have made your choice, press ENTER.   
 
      The display now automatically uses the units you have selected 

when measuring your book’s thickness.  
 
 
 
      Changing the Landscape Text Orientation 
 
      This setting allows you to change the landscape text orientation 

from American to European style.  Changing this setting simply 
rotates any landscape text 180°. 

1.Sheets    2.Inches   3.Millimeters 

American text 
orientation 

European text 
orientation 

•    To change the text orientation, press 3 at the User Settings screen. 
You see: 

  1.American      2.European (rotate  
            landscape text 180°) 

•    Select a text orientation by pressing the corresponding number. 
•    Once you have made your choice, press ENTER. 
 
      The printer now will always print your titles in the landscape 

orientation you have selected. 
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       Setting the Default Font and Font Style 
 
       When the printer is turned on, it automatically uses the font Univers 

Condensed in a Normal style. If you have the itch, you can change 
these settings to reflect your own preferences.  For example, if Palatino 
Bold is your favorite font and font style, you can program the 
PowisPrinter™ to always default to Palatino Bold.  Here’s how: 

 
•     From the User Settings Menu, press the right arrow key, and you’ll see: 

•     If you press 4, the list of PowisPrinter™ fonts appears.  Select the font 
you want as a default by pressing the corresponding number. 

 
•     If you press 5, the list of PowisPrinter™font styles appears. Select the 

font style you want as a default by pressing the corresponding number.  
 
       When you have made your selection, the printer confirms your choices: 

4. SET DEFAULT FONT   5. SET DEFAULT STYLE 

       Now each time you turn on your printer, the machine will assume 
these settings.  Note this will not affect text until the next time the 
printer is turned on, or you select the Default Formats MENU item. 

 
C.   Other Keys 
 
•     Use the REPEAT key when you want to print the same title more than 

once. Here’s how:   
 
       a.    Press the REPEAT key. 
       b.    Enter the number of times you wish to print the same title, and 

press ENTER. 
       c.    Insert a strip. 
       d.    When that strip has printed, insert the next strip (the printer will 

prompt you). Continue until you have printed the desired number of 
strips.  

       If you wish to stop, press ESC at any time. 
 
•     Press the HELP key to get help at any time.  
•     Escape (ESC) acts as a sort of undo key. If at any time you want to go 

back, or if you accidentally hit a key you didn’t mean to hit, just press 
ESC.  

•     Press the BACKSPACE key ( � ) to delete the previous characters you 
have typed.  

•     Press the EJECT key to eject a strip that is in the machine.  
•     Use the ARROW keys to move the blinking cursor.  
•     Press the CLEAR key to delete both lines of text (Figure 12). 
•     Use the 2nd SHIFT key to access extended characters and symbols. 

Default format:   font:   PALATINO        
                  style:  Bold       
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             Orientation Keys 
A           Landscape             
B           Stacked   
C           Portrait                 
 
 
             Zone Keys 
D           Top        
E            Middle     
F            Bottom 
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A.   Step-by-step Procedure  
 
       This section describes how to print a more elaborate Binderstrip™ title, 

using various zones and different orientations. In this procedure, we 
provide specific orientations and zones strictly for example’s sake. Feel 
free to use any zones or orientations you like. It’s your strip, so design it 
the way you want.  

  
1.           To enter a document title, press the ESC key several times until 

you see the following on the keyboard display: 

This display is called the Text Screen. Two lines of text per zone are 
usually available. 

 
2.    Make sure you are in the middle zone by pressing the Middle Zone key 

(Figure 13). 
3.    Now press the Landscape orientation key. (If you choose a different 

orientation, remember that for most books, only a few characters will 
fit in Portrait Orientation.) 

4.    Type a title (for example, your favorite color) on the first line and press 
ENTER.    

5.    Type another title (like your favorite food) on the second line. Your 
screen now might say something like, “Purple hamburgers.” Press 
ENTER. The keyboard display changes to: 

[■] 
[  ] 

       Before we add more zones, let’s adjust the font type. NOTE: you can 
change the font type, size, and style at any point while designing your 
strip. 

 
6.    Press MENU. 
7.    Press 1 (SELECT FONT). Select a font. For example, Times.  
8.    Choose which zone(s) this change will affect.  
 
       After confirming your choice, the printer returns to the Text Screen. 
 
9.    Since we want to add more zones, press the Bottom Zone key. 
10.  Press the Portrait orientation key. Because the bottom zone is empty, 

the display reads: 

Press PRINT or use ZONE KEYS in left 
corner to add text to other zones 

11.  Type in a word (for example, your first name) on the first line and 
press ENTER. 

12.  Type in another word (like your last name) on the second line and 
press ENTER.  The keyboard display changes to: 

[■] 
[  ] 

       Before we print, we want to adjust the font style. 

Press PRINT or use ZONE KEYS in left 
corner to add text to other zones 

C A B 

D 

F 

E 
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13.  Press MENU. 
14.  Press 3 (FONT STYLE). Select a font style (for instance, Italic). 
15.  Choose which zone(s) this change will affect. After confirming 

your choice, the printer returns to the Text Screen. 
16.  Press the PRINT key. The screen now displays:   

      Depending on the book width or number of sheets you enter, the 
printer determines the appropriate width Binderstrip™ you need.  

 
17.  So measure how wide your book is, or count how many sheets 

you’re binding. (If you have non-standard pages [thick covers, etc.], 
please measure the book and enter that thickness.) Using the M, I, 
and S keys, enter the book thickness in millimeters, inches, or 
number of sheets.  Press ENTER. The PowisPrinter™ then 
determines the strip width suitable for your book.  

 
18.  After you have entered the book thickness, the keyboard display 

says: 

ENTER BOOK THICKNESS:   __  sheets 
S=sheets, I=in, M=mm 

NOTE:  N/M/W = NARROW OR MEDIUM OR WIDE 
 
19.  Insert the Binderstrip™ into the Feed Entry (figure 2). Make sure 

that: 
 
•    The Binderstrip™ is adhesive side up 
•    The Binderstrip™ is fed straight into the machine 
•    You are feeding only one strip (sometimes they stick together in 

the box) 
•    The Binderstrip™ width matches the width the printer has 

requested 
•    The Binderstrip™ is clean and no Binderstrip™ fragments are 

attached 
 
      If not, an error message will appear and you’ll need to re-feed the 

correct strip into the machine.   
 
20. Once you’ve inserted the Binderstrip™ correctly, the 

PowisPrinter™ will print on it and eject it so that it’s ready for 
binding. If you followed our model, your strip should look 
something like the strip in the Getting Started example (figure 14).  

 
      Pretty snazzy, huh? 

 INSERT N/M/W STRIP 
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B.   A Few Words About Printing 
 
      When your text is too long or too tall for a strip 
 
      If your text is too long or too tall for the strip, the printer won’t 

print your strip. Once you press PRINT, the printer will advise you 
of this.  This message — which tells you what to do — flashes very 
quickly, and then returns to the Text Screen. If you miss it, try one 
of the following options. 

 
1.    DELETE SOME TEXT 
       
      If you do have too much text, an obvious solution is to edit some 

of your title, so that it’s shorter.     

Example: 

Original Title 
(Too Long) 

Edited Title 

2.    REDUCE FONT SIZE, OR AUTOFIT 
      Your text might not fit because the font size is too tall. For 

example, if you have a narrow book, and you’ve selected 96 as 
your point size, the title’s not going to fit. To correct this, press 
MENU, and select 2 (FONT SIZE). Either decrease the font size, 
or press A to AutoFit. If you choose AutoFit, the printer will 
automatically size your text to fit the width of your book. 

Example: 

Original Title 
(Too Tall) 

Resized or 
AutoFitted 
Title 
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3.    CHANGE ORIENTATION 
      Perhaps your text won’t fit because it’s too long for its orientation. 

This usually happens in Portrait orientation, which fits only a few 
characters. Both Landscape and Stacked orientations fit more text, 
so try either one. 

Example: 

Original Title 
(Too Long) 

Reoriented 
Title 

      Sometimes it’s a combination of these three elements, so 
experiment until one works. If you want the quickest solution, try 
AutoFit. It usually gets the job done. 

When your book is very thin 
 
      If your book is less than 38 

sheets, the front flap of the strip 
(the part that wraps around the 
cover) is actually wider than the 
spine. In this situation—when 
the front flap has more room for 
titling—the PowisPrinter™ 
offers you the option of printing 
your title on this flap. Using this 
front flap gives you a little more 
space and flexibility. 

 
      How it works:  when you have 

your title design ready to go, 
press PRINT and enter your 
book thickness.  The printer will 
suggest your front-flap option: 

      Press Y to print on the front flap; N to print your title on the book 
edge as usual.  If you choose to print on the book edge, don’t 
worry about your title’s appearance.  It’ll be as good-looking as 
ever—if a touch small. 

Book is too thin for best edge titling. 
Print front flap of strip instead? (Y/N) 

A front-flap title 
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JAZZ STRIP 
 
 
Top zone 
Orientation:  
Landscape 
Text:  JAZZ 
Font  type:   
Bodoni 
Font size:   
AutoFit (72) 
Font style: Bold 
 

C.   Sample Elaborate Titles (and How To Make Them) 

Middle zone 
Orientation:   
Landscape 
Text: 
1st line: 
The Years  
From 
2nd line:   
1938 thru 1960 
Font type:  
Univers 
Font size:  30 
Font style:  Italic 

Bottom zone 
Orientation:           
Portrait 
Text:  A B A L O S  
(spaces between  
each letter) 
Font type:   
Univers  
Condensed 
Font size:  12 
Font style:   
Normal 
 
 
Wide strip, 375  
sheets 

SMILEY FACE 
STRIP 
 
Top zone 
Orientation:  
Landscape 
Text:  : )    : )    : )  
  :) (one space 
between colon 
and right paren-
theses; four  
spaces between 
each “face”) 
Font type:  Times 
Font size:   
AutoFit 
Font style:   
Normal 

JAZZ STRIP 
 
 
Top zone 
Orientation:  
Landscape 
Text:  JAZZ 
Font  type:   
Bodoni 
Font size:   
AutoFit (72) 
Font style: Bold 
 

Middle zone 
Empty 

Bottom zone 
Orientation:  Portrait 
Text:  SMILE 
Font type:  Bodoni 
Font size:  AutoFit 
Font style:  Normal 
 
 
 
 
 
 
 
 
Medium strip, 250 
sheets 
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T H E  P O W I S P R I N T E R ™  A N D  Y O U R  
C O M P U T E R :  A  G R E A T  C O M B I N A T I O N  

VI 

      Imagine being able to connect your PowisPrinter™to your 
computer. Imagine being able to access your computer’s fonts, 
insert graphics and logos, utilize five zones, and save titles on your 
hard drive. Imagine being able to see the entire Superstrip™ as 
you design it. You can. Using your PowisPrinter™ with your 
computer is not only possible, but easy.  

 
 
A.  System Requirements 
 
      If you plan to use the PowisPrint™ software, make sure your 

computer meets the system requirements before installing the 
software.   

 
      PC requirements: 
      •     A 486 (or Pentium class) processor 
      •     At least 16 megabytes (MB) of RAM  (optimum 32 MB of 

       RAM) 
      •     At least 20 MB of free hard-disk space 
      •     A Microsoft or 100% compatible mouse recommended 
      •     A RS-232 serial port 
      •     Windows™ 95 or 98 or Windows™ NT operating system 
      •     A 17”  VGA monitor recommended 
 
B.          Connecting the PowisPrinter™ to a Computer 
 
      1.    Connect the computer cable to the rectangular 9-pin serial 

port on the back of your computer 
 
      2.    Since you will now use your computer’s keyboard to create 

titles, unplug the PowisPrinter™ keyboard from the printer’s 
bottom Input Port.  

 
      3.    Now connect the other end of the computer cable into the 

PowisPrinter™ bottom Input Port (figure 1). 
 
 
C.         Installing the PowisPrint™ Software 
 
      To install the software, please refer to the PowisPrint™ Software 

User’s Manual at the end of this manual. 

P O W I S P R I N T E R ™  +  Y O U R  C O M P U T E R  
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T H E  P O W I S P R I N T E R ™  A N D  A  
F A S T B A C K ® B I N D E R — A  D Y N A M I C  D U O  

VII 

      You can set up the PowisPrinter™next to a Fastback®binder, so 
that after your strip prints, it goes directly to the binder for binding. 
Which means you can print and bind in one easy step!  Once you 
have the two machines docked, you don’t have to worry about re-
feeding the strip into the binder to bind a document.  And you can 
save time binding multiple books with the same title, because the 
printer can print a strip while the previous book (with the same 
width and title) is being bound. Fancy, huh? 

 
 
A.  Fastback® Binder Docking Kit 
 
      If you plan to dock your Fastback® Model 11 or Model 15 to the 

PowisPrinter™, please contact your authorized Fastback® 
representative.  They’ll know the details regarding the service 
modification to your Fastback® binder that allows the Fastback® 
binder to talk to the PowisPrinter™. 

 
B.   Docking the PowisPrinter™ to a Fastback® Binder 
 
1.    Make sure that your Fastback® binder has been modified to talk to 

the PowisPrinter™.  
2.    Place the PowisPrinter™’s alignment tab close to the Fastback® 

Binder’s Binder Strip Guide.   
 
      •     For a Model 11, align the printer to the binder so that the 

binder’s strip guide end is nestled in the inside corner of the top 
alignment tab (Figure 15).  

      •     For a Model 15, use the bottom alignment tab (Figure 16).   
 
3.    Position the two machines so that there is access to the 

PowisPrinter™’s front door.   
4.    •     If you have a Model 15, place the 6" long purple cylinder onto 

the keyboard’s foot (Figure 17) and place the keyboard in front of 
the Fastback® binder. 

      •     For the Model 11, place the keyboard on top of the front 
panel of your Fastback binder (Figure 18). 

5.    Run the keyboard cable directly to the back of the binder, then 
over to the printer’s bottom Input Port. 
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C.  Exciting Printing Options 
 
      When docked, the PowisPrinter™ and a modified Fastback® 

binder sense each other’s presence, which explains how you can 
print and bind in one smooth operation.  

 
1.    Load the book into the binder and press the green BIND button 

to activate the book clamps. (If you need help, follow steps 1–5 on 
page 7 of the Fastback® Model 11 user’s manual, or steps 1–4 on 
page 3 of the Fastback® Model 15 user’s manual.) 

2.    Now go to your PowisPrinter™ keyboard. Enter the text you wish 
to print, and if desired, modify the font type, size, or style. Press 
ENTER. The screen says: 

Press PRINT or use zone keys in left 
corner to add text to other zones 

      There are two methods of printing and binding a document when 
the PowisPrinter™ is docked to a Fastback® binder.  If you use 
Method A, you can print and bind the strip in one operation. 
Method B, on the other hand, allows you to print the strip, review 
what it looks like, and then re-feed it to bind the document.  

 
Method A:  Quick ‘n’ Easy — Print and bind in one operation  
 
3. Press the PRINT & BIND key to print the Binderstrip™. After 

printing, it will be sent directly to the Fastback® binder for binding 
(figure 12). 

4.    The keyboard display now tells you to insert the correct strip size: 

INSERT N/M/W STRIP 

NOTE:  N/M/W = NARROW OR MEDIUM OR WIDE 
 
      When you insert the correct width Binderstrip™ into the Feed 

Entry (figure 2), make sure that: 
 
      •     The Binderstrip™ is adhesive side up 
      •     The Binderstrip™ is fed straight into the machine 
      •     You are feeding only one strip (sometimes they stick together 

       in the box) 
      •     The Binderstrip™ width matches the width the printer has 

       requested 
      •     The Binderstrip™ is clean and no Binderstrip™ fragments are 

       attached 
 
5.    The PowisPrinter™ now prints on the Binderstrip™, and ejects it 

directly to the Fastback® binder for binding.   
6.    When the binder’s book clamps open, remove the bound 

document and place it spine down in the Cooling Rack. Allow it to 
cool for five to seven minutes. 

P O W I S P R I N T E R ™  +  A  F A S T B A C K ®  
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Method B:  Print, review, re-feed and bind 
 
3.    Press the PRINT key.   
4.    The keyboard display will now tell you to insert the correct strip 

size, based on the width of the document in the Fastback® binder: 

INSERT N/M/W STRIP 

NOTE:  N/M/W = NARROW OR MEDIUM OR WIDE 
 
      When you insert the Binderstrip™ into the Feed Entry (figure 2), 

make sure that: 
 
      •     The Binderstrip™ is adhesive side up 
      •     The Binderstrip™ is fed straight into the machine 
      •     You are feeding only one strip (sometimes they stick together 

       in the box) 
      •     The Binderstrip™ width matches the width the printer has 

       requested 
      •     The Binderstrip™ is clean and no Binderstrip™ fragments are 

       attached 
 
5.    The PowisPrinter™ will now print the Binderstrip™, and eject it. 
6.    Inspect the Binderstrip™ printing for accuracy.  Jump back to step 

2 to correct any text errors. 
7.    Press the BIND ONLY key to send the Binderstrip™ through the 

PowisPrinter™ to the Fastback® binder to bind the document.   
8.    Insert the printed Binderstrip™, adhesive side up, back into the 

PowisPrinter™. 
9.    When the Fastback® binder’s book clamps open, remove the 

bound document and place it spine down in the Cooling Rack. 
Allow it to cool for five to seven minutes. 
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A.    Frequently Asked Questions (and Answers!) 
 
 
       Q:    I feel like I’m forcing the strip into the printer. Am I doing it 

wrong? 
       A:    As long as you insert the Binderstrip™ adhesive-side up, into the 

feed entry (the purple chute on top of the PowisPrinter™), you’re fine. 
While you shouldn’t jam the Binderstrip™ into the entry, you should guide 
it until the Printer grabs the strip. 

 
       Q:    What if I want to undo the last thing I did? 
       A:    In most instances, ESC serves as an undo button. If you accidentally 

hit a button, hit ESC and it will usually take you back to the Text Screen. 
 
       Q:    What does the MENU key do? 
       A:    Pressing the MENU key opens a menu of keyboard options. Here 

you can change the Font Size, Style, and Type; Save and Recall Titles; 
Review titles; and set the Language, Measurement Units, and the Default 
Styles. Simply press MENU to utilize these options.  

 
       Q:    What is the book image in the bottom left corner of the keyboard? 
       A:    That book, and the adjacent buttons, depict the zone and orientation 

keys. There are three buttons on the spine of the book, representing the 
three different zones. You can put text in each of these three zones. The 
buttons above the book are the orientation keys, which format how the 
text orients on the spine.  

 
       Q:    What do the lights mean on the edge of the book image? 
       A:    The zone lights mean two things. A flashing zone light indicates what 

zone you are currently in. A constant zone light indicates where you have 
entered text. 

 
       Q:    How can I change how the script looks? 
       A:    Press MENU. Press 1 (SELECT FONT). Press the number of the font 

you want. The screen now asks if you want to change all the zones or just 
one of them. Make your selection. If you don’t choose any — and just 
press ENTER — the PowisPrinter™ changes the font only in the zone you 
are currently in. 

 
       Q:    How do I make the font bigger or smaller? 
       A:    Press MENU. Press 2 (FONT SIZE). Enter the font size you want. If 

you want the PowisPrinter™ to automatically size your text to fit the strip, 
press A for AutoFit. If AutoFit is already on the screen, the screen will not 
change when you press A. The PowisPrinter™ registers your AutoFit 
choice. Press ENTER. 

 
       Q:    I’m confused about font styles (normal, bold, italic, and bold-italic). 

Can I use two within one zone, like: “DELICIOUS CORN”? 
       A:    Not really. You can print a title like this if you’re using your computer, 

but only by using two zones very close together. But whether you’re using 
a computer or the PowisPrinter™ keyboard, you can use only one style 
per zone. So your title could be: 

 
       DELICIOUS CORN  or  DELICIOUS CORN  or   
       DELICIOUS CORN  or  DELICIOUS CORN 
 
       While you can’t use two styles in one zone, you can use different styles in 

different zones. So your top zone could be bold-italic, the middle zone 
normal, and the bottom bold.  (This also applies to font style and size. 
While you can have different sizes and types in different zones, you can 
only have one size and type within each zone.)              

P R O B L E M  S O L V I N G  VIII 

P R O B L E M  S O L V I N G  
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       Q:    Is there a way to review what font I’ve chosen? 
       A:    Yes. Press MENU. Press the right arrow key to move to the next 

screen. Press 7 (REVIEW TITLE). The display screens now shows what 
font types, sizes, and styles you have selected for each active zone.
        

 
       Q:    What are the “default formats”? 
       A:    The default formats are the built-in settings for the font type, style, 

and size. For the PowisPrinter™, they are Univers Condensed, Normal, 
and AutoFit. Each time you turn off your printer, the machine assumes 
these settings. For example: if you change the font to 12 point Times, 
Bold-Italic, and then turn off the machine and turn it back on, the 
machines resets, and the formats revert to Univers Condensed, Normal, 
and AutoFit.  

 
       Q:  Can I change the default formats? 
       A:  Yes.  Simply press MENU, press the right arrow key three times, and 

press “U” for User Settings.  Now press the right arrow key once to move 
to the next screen. You should see options to set the default font and 
style.  Select the font and style you prefer, and the printer will now use 
these as the default formats.  

 
       Q:    Can I enter text in all three zones? 
       A:    Yes! Not only can you enter text in all three zones, but each zone 

can be oriented differently. You can also have different fonts, font sizes 
and styles in each. 

 
       Q:    How do I see what I’ve written in all three zones? 
       A:    Press MENU. Press the right arrow key to move to the next screen. 

Press 7 (REVIEW TITLE). The display screen now shows you the text in 
each zone, followed by the orientation, font type, size, and style you have 
selected.  

        
       Q:    After I inserted the strip, an error message flashed on the screen, 

and then disappeared. I don’t know what the problem is, but it’s not 
printing my strip. What’s going on? 

       A:    That quick message alerts you that you have too much text to print 
on the strip, and tells you how to fix it. Depending on the situation, the 
printer offers you up to three solutions:  reduce your font size (or 
AutoFit), change the orientation of the text, and/or delete some text. See 
the section, A Few Words About Printing (p. 17), for more details. 

 
       Q:  What if I want the screen text to display in Spanish?  Can I do this? 
       A:   Sure.  In fact, you can change the screen text to any of nine languages:   

English, Spanish, German, French, Italian, Dutch, Swedish, Danish, and 
Norwegian!  Simply press MENU, press the right arrow key three times, 
and press “U” for User Settings.  Select 1 for Language, and choose your 
preferred language.  Now press ENTER, then  ESC, to activate the 
language. 

  
       Q:    Can I have two different colors on the same strip? 
       A:    No. The printer holds only one color cartridge at a time, which limits 

you to one color for each strip. For example, if you’ve loaded a gold 
cartridge in the printer, it can only print gold ink. While there’s a rainbow 
of cartridge colors to choose from, you can only use one at a time.  

P R O B L E M  S O L V I N G  
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       However, there is a way to get more than one color on the strip. 
Conceivably, you could print a strip in gold, change the  gold cartridge to 
silver, then reprint the strip. You would then have both gold and silver on 
your strip. 

 
       Q:    How do I know what size strip to insert? 
       A:    After you press PRINT, the printer will prompt you for your book’s 

thickness. Simply measure how wide your book is, or count how many 
sheets you’re binding. Then enter this number. The PowisPrinter™ will do 
the hard work and determine the strip width suitable for your book. 

 
A handy reference: 

P R O B L E M  S O L V I N G  

You’ll use a… 
 
 
Narrow Binderstrip™  
 
 
 
Medium Binderstrip™  
 
 
 
Wide Binderstrip™ 

If your book width is between… 
 
10–125 sheets 
0.04–0.5 inches 
1–12 mm 
 
126–250 sheets 
0.6–1 inches 
13–25 mm 
 
251–375 sheets 
1.1–1.5 inches 
26–38 mm                             

B.   Symptoms & Solutions 

Symptom Possible Cause Probable Solution 

Machine doesn’t work  •No A.C. Power •Check power cable 

•Fuse blown •Replace fuse  

Can’t insert 
Binderstrip™  

•Binderstrip™ upside 
down 

•Should be adhesive 
side up 

•More than one strip •Feed only one 
Binderstrip™ 

•Wrong Binderstrip™ 
width 

•Insert the size the 
keyboard requests 

•Jammed 
Binderstrip™ 

•Fix jam  

•Machine not ready 
for strip 

•Wait thirty seconds 

Binderstrip™ not 
printed 

•Twisted or damaged 
strip        

•Retry with a new 
Binderstrip™ 

•Jammed cartridge •Replace the cartridge  

•Jammed 
Binderstrip™ 

•Fix jam  

Binderstrip™ not 
ejected or fed to 
Fastback® binder  
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D.  Replacing Fuses 
 
1.    Turn the power OFF, and remove the power cord. 
2.    Below the Power ON Switch at the back (figure 2), check the fuse 

rating and type. 
3.    Obtain a new fuse from your Service Representative. 
4.    Use a standard screwdriver to pry open the fuse holder just below 

the Power Switch.  Hook the screwdriver under the tab. 
5.    Pull out the blown fuse. 
6.    Insert the new fuse. 
7.    Close the fuse holder. 
8.    If a new fuse blows, please contact your dealer. 

P R O B L E M  S O L V I N G  

C.  Keyboard Error Messages 

•PLEASE REMOVE STRIP FROM FEED 
ENTRY 

•Fix chute jam   

•STRIP LOADING ERROR — PLEASE 
REMOVE STRIP AND TRY AGAIN 

•CARTRIDGE EMPTY— PLEASE INSERTA 
NEW ONE 

•Change foil cartridge
(see page 29) 

•STRIP TOO SHORT—MINIMUM STRIP  
LENGTH IS 8.25 INCHES (20.96 cm) 

•Use longer strip 

•STRIP TOO LONG — MAXIMUM STRIP 
LENGTH IS 14.0 INCHES (35.56 CM)           

•Use shorter strip 

•WRONG WIDTH STRIP •Insert width the 
display is requesting 

•HATCH OPEN — REMOVE THE STRIP 
BEFORE CLOSING  
 

•STRIP JAMMED — OPEN HATCH AND 
REMOVE 

•CARTRIDGE DOOR OPEN — CLOSE 
DOOR TO RESUME 

•Close the Front Door 

•OPERATION PRINTHEAD IS TOO 
HOT — WAIT 5 MINUTES 

•Wait 5 minutes to 
resume printing 

•Fix hatch jam   
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B 

A 

D 
C 

D I A G R A M A /S C HÉ M A / F I G U RE  19 A             Top Hatch  
B              Feed Entry 
C             Front Door 
D             Binder Exit 

WARNING: Do not 
touch the silver metal 
bottom of the printhead. 
It can be extremely hot! 

P R O B L E M  S O L V I N G  

E.   Fixing Jams  
 
      The printer can jam a strip in four places — the feed chute, the 

hatch, the front door, and the Binder Exit (figure 19).  See below 
to clear jams in these locations.  If you can’t tell where the jam has 
occurred, check all four places. 

 
      Feed Chute Jams 
      •     Carefully and slowly pull the strip out of the feed entry or feed 

       exit. 
 
      Hatch Jams 
      •     Open the Top Hatch (figure19).  Locate the jammed strip.  

       Gently and carefully pull the strip out of the machine.  It may 
       help to open the Front Door to give easier access and/or 
       visibility (see below). 

      •     Close the Top Hatch. 
 
      Front Door Jams 
      •     Open the Front Door (figure 19). Locate the jammed strip.  

       Gently and carefully pull the strip out of the machine.  It may 
       help to open the Top Hatch to give easier access and/or 
       visibility (see above). 

      •     Close the Front Door. 
 
      Binder Exit Jams 
      •     If something obstructs the Binder exit, a Binderstrip™ can jam 

       here. To fix this, first open the Front Door. 
      •     With the Front Door open, remove the Binderstrip™ from 

       the Binder Exit. It should remove easily. 
      •     Close the Front Door. 

A word about Binderstrips™  
Sometimes during the manufacturing, Binderstrip™ fragments stick to the 
Binderstrips™. These fragments — if inserted into the PowisPrinter™ — can smear 
the foil, jam the machine, or even break the foil cartridge. You can avoid such mishaps 
by inspecting your Binderstrip™ each time you’re about to print. If you notice any 
scraps or fragments, simply brush them off the strip, then insert the strip as usual. 
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F.   Replacing the Foil Cartridge 
 
      Change the foil cartridge when you wish to change the color of 

the printed text, or when the cartridge is empty. 
 
      a.    The PowisPrinter™ will automatically detect when it is time to 

       change the foil cartridge.  The screen will display:  

CARTRIDGE EMPTY-- 
Please insert new one 

      b.    Make sure that a Binderstrip™ is not in the machine.  If one is, 
       close the door, and the strip should eject. If it doesn’t, see 
       Chapter VIII, Fixing Jams, to remove it. 

      c.     Open the Front Door (figure 20). 
      d.    Grasp the foil cartridge at the top and the bottom and pull it 

       straight out of the machine. 
      e.    Take out a new foil cartridge. Remove the orange shipping 

       tab. 
      f.     Look at the cartridge. Does the foil balloon out? If it does, turn 

       the purple wheel on the cartridge clockwise, so the foil 
       tightens up. The foil should have no slack. 

      g.    Now insert the foil cartridge, carefully fitting it over the 
       printhead. The foil should slide in the gap between the drum 
       and the printhead. Listen for a click that tells you the cartridge 
       is snugly in place. 

      h.    Close the Front Door.        

P R O B L E M  S O L V I N G  
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A 

B 

D I A G R A M A /S C HÉ M A / F I G U RE  20 
A             Printhead  
B              Foil Cartridge 
C             Drum 
 

WARNING: Do not 
touch the silver metal 
bottom of the printhead. 
It can be extremely hot! 
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G.  Keeping the Printhead Spic ‘n’ Span 
 
      Keep your printhead running smoothly by periodically using the 

enclosed printhead brush to remove any foil particles or dust that 
may collect around the printhead.  

 
 
H.  When to Call For Service or Technical Support 
 
      If a problem persists after you have read this manual and have 

followed the troubleshooting procedures outlined above, please 
call your authorized Fastback® representative. 

 
      If you need help contacting your local dealer, call Powis Parker at 

510.848.2463 (or 800.321.2463 in the United States) during the 
hours of 6:00 a.m. to 5:00 p.m., Pacific Time. 

 
 
I.    Ordering PowisPrinter™ Accessories or Supplies 
 
      To order PowisPrinter™ Boxed Accessory Kits or Accessory Kit 

parts, please use the following order numbers when speaking with 
your authorized Fastback® representative: 

 
      Part Description                                                Part Number 
      User’s Manual                                                    A1780 
      Cleaning Brush                                                  700-1765 
      Power Cord                                                      551-778 
      Computer (PC to PowisPrinter™) Cable              551-1685 
      PC Software on 3.5" Floppy Disks                        A1770 
      PC Software on CD-ROM                                  A1771 
 
      Foil Cartridge Packs 
      Black                                                                C001 
      White                                                               C008 
      Gold                                                                 C052 
      Red                                                                  C033 
      Green                                                               C023 
      Blue                                                                  C012 
      Silver                                                                C007 
      Variety                                                              CV90 
       
      Fastback® Binderstrip™, Foil Cartridge Packs, and Fastback® 

Bindercovers™ can be ordered from your authorized Fastback® 
dealer. 

 

P R O B L E M  S O L V I N G  
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J.    PowisPrinter™ Model 31 Specifications 
 
      Machine Dimensions:                  9.25" (23.5 cm) deep x 14" (35.6 cm) 

                                                   wide x 12" (30.5 cm) high 
       Weight:                                      22.5 lbs (10.2 kg) 
       Binderstrip™ Lengths:                 A5, 8.5", 9", 11", A4, 14" 
      Average Printing Time:                20 Seconds (can be longer with 

                                                   images) 
       Warm-up Time:                         20 second self-test 
       Power Requirements 
       and Safety Approvals:   
              USA/Canada — P31:             UL, CUL  2.5 A, 115V, 50/60 Hz 
              Europe — P31E:                     CE, TUV  1.25 A, 220-240V, 50/60 Hz 
              Japan — P31J:                        UL, CUL, MITI2.5 A, 100V, 50/60 Hz 
              Mexico — P31M:                   NOM2.5 A, 127V, 50/60 Hz 

P R O B L E M  S O L V I N G  

Fastback® is a Registered Trademark of Powis Parker Inc. 
©Powis Parker 1998 
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SOFTWARE 
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Powis Parker License and Warranty 
 
NOTICE:  POWIS PARKER LICENSES THE ENCLOSED SOFTWARE TO YOU ONLY UPON THE 
CONDITION THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS LICENSE 
AGREEMENT. PLEASE READ THE TERMS CAREFULLY BEFORE OPENING THIS PACKAGE AS 
OPENING THE PACKAGE WILL INDICATE YOUR ASSENT TO THEM. IF YOU DO NOT AGREE TO 
THESE TERMS, THEN POWIS PARKER IS UNWILLING TO LICENSE THE SOFTWARE TO YOU. 
 
LICENSE AND WARRANTY 
The software which accompanies this license (the “Software”) is the property of Powis Parker or its licensors 
and is protected by copyright law. While Powis Parker continues to own the Software, you will have certain 
rights to use the Software after your acceptance of this license. Except as may be modified by a license 
addendum which accompanies this license, your rights and obligations with respect to the use of this Software 
are as follows: 
 
· You may: 
                  (i) use only one copy of the Software contained on the enclosed CD-ROM on a single       
                  computer; 
                  (ii) make one copy of the Software for archival purposes, or copy the Software onto the    
                  hard disk of your computer and retain the original for archival purposes; 
                  (iii) after written notice to Powis Parker, transfer the Software on a permanent basis to      
                  another person or entity, provided that you retain no copies of the Software and the           
                  transferee agrees to the terms of this agreement. 
· You may not: 
                  (i) copy the documentation which accompanies the Software; 
                  (ii) sublicense, rent or lease any portion of the Software; 
                  (iii) reverse engineer, decompile, disassemble, modify, translate, make any attempt to dis 
                  cover the source code of the Software, or create derivative works from the Software; or 
                  (iv) use a previous version or copy of the Software after you have received a disk              
                  replacement set or an upgraded version as a replacement of the prior version, unless you   donate 
the previous version of an upgraded version to a charity of your choice, and such charity agrees in writing that 
it will be the sole end user of the product, and that it will abide by the terms of this agreement. Unless you so 
donate a previous version of an upgraded version, upon upgrading the Software, all copies of the prior version 
must be destroyed. 
 
Limited Warranty 
Powis Parker warrants that the media on which the Software is distributed will be free from defects for a 
period of thirty (30) days from the date of delivery of the Software to you. Your sole remedy in the event of a 
breach of this warranty will be that Powis Parker will replace any defective media returned to Powis Parker 
within the warranty period. Powis Parker does not warrant that the Software will meet your requirements or 
that operation of the Software will be error-free. 
 
THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, 
WHETHER EXPRESS OR IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. THIS 
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH 
VARY FROM STATE TO STATE. 
 
Disclaimer of Damages and Limitation of Liability 
UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT, CONTRACT, OR 
OTHERWISE, SHALL POWIS PARKER BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY 
CHARACTER, INCLUDING WITHOUT LIMITATION, DAMAGES FOR LOSS OR DAMAGE TO ANY 
NETWORK, SYSTEMS, DATA, OR FILES, CORRUPTION OF ANY NETWORK, SYSTEMS, DATA OR 
FILES, LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR 
ANY OTHER COMMERCIAL DAMAGES OR LOSSES, EVEN IF POWIS PARKER HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR LOSSES.  
 
SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION MAY NOT APPLY 
TO YOU. 
 
IN NO CASE SHALL POWIS PARKER’S LIABILITY EXCEED THE PURCHASE PRICE FOR THE 
SOFTWARE. The disclaimers and limitations set forth above will apply regardless of whether you accept the 
Software. 
 

L I C E N S E  A N D  W A R R A N T Y  
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U.S. Government Restricted Rights 
If you are acquiring the Licensed Software on behalf of any part of the U.S. Government, the following 
provisions apply. The Licensed Software and accompanying documentation are deemed to be “commercial 
computer software” and “commercial computer software documentation”, respectively, pursuant to DFAR 
Section 227.7202 and FAR 12.212(b), as applicable. Any use, modification, reproduction, release, 
performance, display or disclosure of the Licensed Software and/or the accompanying documentation by the 
U.S. Government or any of its agencies shall be governed solely by the terms of this Agreement and shall be 
prohibited except to the extent expressly permitted by the terms of this Agreement. Any technical data 
provided that is not covered by the above provisions is deemed to be “technical data-commercial items” 
pursuant to DFAR Section 227.7015(a). Any use, modification, reproduction, release, performance, display or 
disclosure of such technical data shall be governed by the terms of DFAR Section 227.7015(b). 
 
General 
This Agreement will be governed by the laws of the State of California. This Agreement may only be 
modified by a license addendum which accompanies this license or by a written document which has been 
signed by both you and Powis Parker. Should you have any questions concerning this Agreement, please 
write: Powis Parker Customer Service, 775 Heinz Avenue, Berkeley, CA 94710.   
 
For technical support, call your local Fastback® dealer.  If you need help contacting your local dealer, call 
Powis Parker at 1-800-321-2463.  Please have your software license number available when you call. 

L I C E N S E  A N D  W A R R A N T Y  



P O W I S P R I N T E R �   M O D E L  3 1  U S E R ’ S  M A N U A L  

CH I           INTRODUCTION. Briefly 
introduces you to the PowisPrint™ 
Software. 

CH II           GETTING STARTED.  Explains 
the nuts and bolts of getting 
PowisPrint™up and running; then takes 
you step-by-step through printing your 
first strip. 

 
 
 
CH III         GETTING THE MOST FROM 

POWIS PRINT™ . Describes all the 
great features and options PowisPrint™ 
offers.  Explains how to format your 
text, insert images, and more! 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
CH IV        PRINTING. Guides you through 

the Print Window and all your printing 
options.  Shows you how to print titles, 
print and bind, and bind only.  Also 
explains the awesome Repeat Button.   

 
 
 
 
 
 
 
 
CH V          PREFERENCES.  Here you’ll 

discover how to change in PowisPrint™ 
settings, like display language, 
measurement units, and colors! 
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Setting up your computer to your PowisPrinter™ opens the door to a  
zillion possibilities in Binderstrip™ design. With the PowisPrint™ 
software, you can use five zones, add up to five lines of text, insert 
bitmap images, access all the fonts on your computer, and most 
importantly, view your strip as you design it.  And since you’re working 
on your computer, you use a full-sized keyboard to design your strip!   
 
Before we get rolling, please note that this manual assumes you're 
familiar with your computer and know how to: 
             • Open an application 
             • Use menus, dialog boxes, and buttons 
             • Use the mouse and keyboard 
If you need help performing any of these tasks, please refer to the 
manuals provided with your computer.   
 
Without further ado, let's get started. 
 

I N T R O D U C T I O N  I 

I N T R O D U C T I O N  
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A.  Setting Up 
 
      1.  System Requirements 
      Make sure your computer meets the system requirements before 

installing the software.  
 
      PC requirements: 
      • A 486 or Pentium Class processor 
      • At least 16 megabytes (MB) of RAM; 32 MB of RAM 

recommended 
      • At least 20 MB of free hard-disk space 
      • A 17” VGA Monitor recommended 
      • A Microsoft or 100% compatible mouse recommended 
      • An RS-232 serial port 
      •Windows 95 or 98, or Windows NT operating system 
 
 
      2.  Connecting the PowisPrinter™ to a Computer 
              
             a.  Connect the computer cable to the rectangular 9-pin serial 

       port on the back of your computer. 
 
             b.  Since you will now use your computer’s keyboard to 

       create titles, unplug the PowisPrinter™ keyboard from the 
       PowisPrinter™’s bottom Input Port.  

 
             c.  Now plug the other end of the computer cable into the 

       PowisPrinter™’s bottom Input Port. 
 
 
      3.  Installing PowisPrint™ Software 
              
             a.  Prior to running the software, make sure your display 

       resolution is 800x600 pixels or higher.  To change your display 
       resolution, position the mouse cursor on the Windows 
       desktop background (not on an icon or a running-application 
       window).  Press the Right mouse button, and select 
       Properties. This brings up the Display Properties window.  
       Select the Settings tab, and select a screen resolution of 
       800x600 or higher.  

 
             b.  Insert the PowisPrint™ Software CD-ROM into your CD-

       ROM drive.  If you do not have a CD-ROM drive, please 
       contact your Fastback® representative for 3.5” floppy 
       diskettes. 

 
             c.  If your system is set to auto-run the CD when inserted, the 

       installation program will start automatically, and you may 
       proceed to step e.  Otherwise, select Run from the Windows 
       Start Menu. 

 
             d.  In the Open box, type D:SETUP.  Press Enter.  You will 

       need to substitute the letter of your CD-ROM drive if it is not 
       D:. You can also use the Browse button to find your CD-
       ROM if you don’t know what letter it is. 

G E T T I N G  S T A R T E D  II 

G E T T I N G  S T A R T E D  
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             e.  Follow the on-screen instructions. 
 
             f.  The installation creates an icon on the Start menu, within 

       Programs. 
 
             g.  The first time you run the software, you need to specify 

       the serial communications port (COM port) you are using 
       with your PowisPrinter™. When you are connecting the cable 
       for the PowisPrinter™ to the port on the back of your PC, 
       you may find that the ports are labeled.  In many cases, 
       COM1 and COM2 are labeled A and B, respectively.  Other 
       ways to determine available ports:     

 
             For Windows 95 
             • Position the mouse over the My Computer icon on the 

       Windows desktop.   
             •Press the Right mouse button, then select Properties.  
             • In the System Properties window, click the Device Manager  
             tab, then click the  +  mark next to Ports (COM & LPT).  This 

       shows a list of COM ports on your computer.  
 
             For Windows NT 4.0 
             • From the Start menu, select Settings, then Control Panel.   
             •Double click the Ports icon.  This lists the COM ports 

       available.  
 
      COM ports higher than COM2 are usually modems.  If only one 

port is listed, you must use that port with the PowisPrinter™.  If 
both COM1 and COM2 are listed, you may use either one, but 
make sure you connect to the port you designate. 

G E T T I N G  S T A R T E D  
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B.  Printing a Quick Title 
 
      Let’s try printing and saving a quick title. 
 
      1.  Open the PowisPrint™ software by going to your Start menu.  

Select Programs, and locate PowisPrint™.  
       
      2.  When you open PowisPrint™,  a new Design Window 

automatically opens.  The Design Window says “Design Window 
1” in its title bar, and opens with default settings, so you can 
immediately begin designing your strip.  

 
      3.  Enter a word (for example, your name), using your computer 

keyboard.  
 
      4.  Now go to the File menu and select Print, or click on the 

small printer icon in the main window.  
 
      5.  The Print Window appears on your screen.  Wait 

momentarily while the PC creates a communication link with the 
PowisPrinter™.  When the “Please wait” message disappears, the 
“Online” and “Ready” lights will turn green.  For now, don’t worry 
about the rest of the Print Window contents.  Simply click the 
“Print” button.  A message appears at the top of the Print 
Window, telling you which width strip to insert.  

 
      6.  Insert the correct width strip into the printer, adhesive side 

up.  It’s very important that you insert the strip the proper way, 
to avoid damaging your printer.  The strip is gently curved, as is 
the strip guide, to help you insert it properly.  

 
      7.  While the PC is sending data to the printer, the green 

“Receiving Title” light blinks.  When printingbegins, the “Printing” 
light turns green.  When the printer is finished printing, it ejects 
the strip from the PowisPrinter™ Feed Exit (below the purple 
chute). 

 
      8.  To exit the Print Window, press the “OK” button.  
 
      9.  Now save the title you just printed.  Saving a title design is 

exactly like saving any other document.   Select Save or Save 
As… from the File menu, or press the shortcut button with the 
small floppy disk icon on it.  This opens a standard Windows 
dialog box.  

 
      10.  Designate a destination for the file. 
 
      11.  Use your name (for example) as the file name.  Press 

“Save.”  (Note the title extension for PowisPrint™ title designs is 
“ttl.”) 

 
And that’s it! 
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      Chapter 2 highlights some of PowisPrint™’s best features—
features that will make your Binderstrips™ even more interesting 
and dynamic.   

 
A.  Text Layout 
 
      Use your Design Window tool bar to change thesefeatures. 
 
      1.  Font Type 
      Select a font using the Font Selection key on the tool bar.  (The  
      available fonts are the TrueType™ fonts already loaded on your  
      computer.) 
 
      2.  Font Size 
      To adjust the font size, use the up and down arrow keys in the 

Font Size area on the tool bar.  (You cannot change the font size 
by entering a number directly in the Size box.) Your point size 
range is 6      to 200.  If you don't select a font size, the software 
automatically AutoFits your text to the zone size. 

              
      NOTE: Once you manually reset the font size, you deactivate 

AutoFit.  Without AutoFit, you can exceed the zone boundaries, 
and enter too many characters, or select a font size that is too big 
for your book.  In this case, the PowisPrinter™ will print exactly 
what you’ve entered—whether it fits or not.  To avoid making 
design errors, we recommend using AutoFit. 

 
      3.  Font Style 
      Using the Font Style keys, choose which style you want:  bold, 

italic, and/or underline.  You may have one, two, or all three of 
these styles simultaneously in one zone.  The style(s) you select 
apply to all the zone contents. 

 
      4.  Character Spacing 
      Use the up and down arrow keys in the Spacing area to adjust the 

space between the characters.  You have a range of 90% (tight) to 
130% (loose).  100% is normal character spacing.   Note that 
changing the character spacing deactivates AutoFit.  To reactivate 
AutoFit at the new spacing, press the AutoFit button on the 
toolbar, or go to the Format �Text �AutoFit.  PowisPrint™ will 
now automatically size your text (at the new spacing you've 
selected) as large as possible to fit within the zone boundaries.  

 
      5.  Aligning Text 
      Within each zone, you can left-align, center-align, or right-align your 

text.  Use the Alignment keys on the tool bar to place your text.  
       
      6.  AutoFit 
      PowisPrint™ AutoFit is just like AutoFit on your PowisPrinter™ 

keyboard.  It automatically selects the largest font size to fit the 
zone height and width. 

       
                                                                 (Continued on page 42)  

G E T T I N G  T H E  M O S T  F R O M  
P O W I S P R I N T ™  III 

G E T T I N G  T H E  M O S T  F R O M  P O W I S  P R I N T ™  
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      Using AutoFit, you don't have to worry about the right size font—
AutoFit figures it out for you. It’s true! 

 
      When you open a Design Window, AutoFit is active. Once you 

modify the font size, though, you deactivate AutoFit.  However, if 
you change orientations in the zone, or move to a new zone, 
AutoFit reactivates.  You can also reactivate AutoFit by pressing 
the AutoFit button in the Design Window, or going to the Format 
menu, then Text, and choosing AutoFit.  

 
      Note:  Without AutoFit, you can exceed the zone boundaries, and 

enter too may characters, or select a font size that is too big for 
your book.  To avoid making design errors, we recommend using 
AutoFit. 

 
USE THE FORMAT MENU TO ACCESS THESE FEATURES. 
 
      7.  Apply Style in All Zones 
      This convenient feature applies the font type and styles of the zone 

you’re currently in to all other zones.  For example, if you’re 
working in a zone, using Times New Roman bold, and you want to 
make your other zones match this, simply go to Format � Text, 
and choose Apply Style in All Zones.  Now all zones reflect Times 
New Roman bold.  

 
REMINDER:  Apply Style in All Zones applies only to character 
formatting (i.e., font, style, size, and character spacing).  This means any 
line spacing you set in one zone will NOT transfer to other zones 
when you select Apply Style in All Zones.  You must apply line spacing 
to each zone separately.      
       
      8.  Spacing 
      This feature allows you to adjust the character and line spacing.  

To take advantage of this, go to the Format � Text � Spacing.  
The Spacing box pops up. 

 
      Line Spacing 
      To change the amount of space between multiple lines of   text, 

click the up and down arrow keys next to the Line Spacing 
Indicator box (Figure 1).  Normal line spacing is 100.  You can 
decrease the spacing to 50, but you cannot increase it beyond 100.   

 
NOTE: This feature only applies to text in Landscape and Portrait 
orientations, since Stacked orientation allows only one line of text.  
 
      Character Spacing 
      You can control the individual character spacing from the Design 

Window, or by going to Format � Text, and selecting Spacing.  
Like the control in the Design Window, simply click the up and 
down arrow keys to create more or less space between 
characters.  You may expand spacing to 130, and  condense it to 
90 (100 is normal spacing).  Any character spacing changes, either 
in the Spacing control box or the Design Window, will be 
reflected in both places.  (For more information on Character 
Spacing, see page 40.)  
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D I A G R A M A /S C HÉ M A / F I G U RE  1 



P O W I S P R I N T E R �   M O D E L  3 1  U S E R ’ S  M A N U A L  43 

      If you want to change the character spacing in all zones, go to the 
Format � Text menu, and select Apply Style in All Zones.  This 
automatically matches the character spacing settings in the inactive 
zones to the new character spacing in the active zone.  Sometimes 
after doing this, text in the inactive zones appears cut off.  Never 
fear!  Simply click AutoFit off then back on in each zone, and the 
text will be resized at the new spacing setting.  

 
      When you finish adjusting the line and character spacing, hit OK. 

        
B.   Text Orientation 
 
      You can orient your text in different orientations with the buttons 

labeled “ABC” on your Design Window’s bottom tool bar.  You 
have three orientations to choose from:  Landscape, Portrait, and 
Stacked.  These orientations refer to how text appears on the strip 
(Figure 2).  

 
      Fascinating facts about orientations: 
 
      •     You can change the orientations at any time while designing 

       your strip. 
      •     In Landscape and Portrait orientations, you can enter up to 

       five lines of  text. Yes, five! Just press ENTER when you 
       want to create a new line.  

      •     Stacked orientation allows only one line of text. 
      •     If you have a lot of text, try Landscape orientation.  
      •     Although you can use only one orientation per zone, you can 

       use different orientations in different zones.  Yahoo!      
 
C.   Zones 
 
      A zone designates a certain area on a strip.  You can put text or an 

image in a zone, and adjust it to fit your design needs.  And while 
the PowisPrinter™ keyboard offers three zones, PowisPrint™ 
software lets you use up to five.  Which means you can place text 
or images practically anywhere on the strip.  

 
      1.  Zone Bars 
      Along the bottom edge of the Design Window are rectangular 

bars (“zone bars”) that designate where the zones are in your 
design.  The default setting has three zones, so three bars are 
displayed when you open the Design Window.  

              
      Only one zone can be active at a time.  The active zone is 

designated by the white zone bar; inactive zones by grey zone bars.  
To activate a different zone, simply place your cursor in the 
corresponding area on the strip or on the bar itself, and click your 
mouse.  The zone you click becomes active, and the zone bar 
directly beneath it changes from grey to white.  (Don't like those 
colors?  You can change ‘em—see Chapter 4, “Preferences,” page 
56.) 

Tip: 
Use CTRL 

+ a left or right 
 arrow key to tab  
between zones. 

Landscape 

Po
rtr

ai
t 

S t a c k e d 
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      2.  Adding a Zone 
      To add a zone, go to the Insert menu, select Insert Zone, then 

choose Left or Right.  This inserts a new zone to the right or left of 
the active zone. 

 
      3.  Clearing a Zone 
      Clearing a zone deletes all the text or the image in a zone.  To clear 

the contents of a zone, insert the cursor in the zone you want to 
clear.  Now go to the Edit menu, and select Clear Zone Contents.  

 
      4.  Removing a Zone 
      Removing a zone deletes the zone itself.  To remove a zone, first 

insert your cursor in the zone you want to delete.  Clear its contents, 
if it has any (you cannot remove a zone that contains text or an 
image).  After clearing the zone, go to the Edit menu and select 
Remove Zone. 

 
      5.  Resizing Zones 
              

a.  Resizing One Zone 
You may resize a single zone by placing your cursor at the zone 
bar’s edge.  Your arrow becomes a double-ended, horizontal 
arrow.  In this mode, click and hold the mouse button and slide 
the zone bar’s boundary to its new location. 
                           
b.  Resizing Two Zones 
To resize two zones simultaneously, place your cursor in the gap 
between two zone bars. Your arrow becomes a little hand.  
Click the mouse button and hold it down, while sliding to the 
left or the right.  This resizes the two zones simultaneously, 
maintaining the gap between them.  

 
REMINDER:  the Binderstrip™ has fixed one-inch right-and-left margins.  
You cannot edit these margins, nor can zones extend   into them. 
 
      6.  How Styles Work in a Zone 
      The style choices you make affect the entire contents of the active 

zone.  For example, if you enter text, then press the “Bold” style 
button, all text in the zone becomes bold.  Or if you’re in a zone, and 
press the Landscape orientation, everything in the zone orients in 
Landscape.  You have many formatting options, but you can use only 
one of each per zone—i.e., each zone may contain only one font, at 
one point size, in one style, in one orientation, at one alignment 
setting.   

 
      So while you can’t have a single zone read “Stubborn burros”, you 

can use two zones to create a similar effect.  You can also type text 
in different styles in any drawing program, save it as a monochromatic 
bitmap image, and then insert it on your strip (for more details, see 
“How to Make a Strip Like This,” page 46).            

 

44 
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D.    Images 
 
       PowisPrint™ software allows you to include monochromatic, standard 

bitmap images (e.g., logos, scanned images, clip art) in your title design.  It 
also automatically fits your image to the zone you put it in, according to 
the zone size and the book thickness. 

  
       1.  Inserting an Image 
 

a.  Select an empty zone by placing your cursor inside it. You cannot 
insert images into zones with text or another image. 
 
b.  To insert an image, go to the Insert menu, and choose Image.  
The “Insert Image” dialog box opens.  
 
c.  Click the “Load Image” button.  A standard Windows “Open file” 
dialog box appears.  
 
d.  Navigate to the folder containing the bitmap file you want to 
insert in your title design. Select the file and click “Open”.  The image 
you selected now appears in the preview area in the “Insert Image” 
dialog box. 
 
e.  If you choose, rotate the image in 90° increments by clicking the 
up and down arrows next to the “Rotate Image” box.  You can also 
invert the bitmap's colors by clicking the “Invert Image” box.  When 
the image is formatted correctly, click “OK.” 

               
       This returns you to the Design Window, which now displays the image 

you have inserted on the strip.  The image automatically scales to fit the 
zone dimensions, and adjusts each time you make a dimension change to 
your design.  Nifty! 

 
       Remember:  You can insert only one image per zone.         
        
       2.  Formatting an Image 
 

a.  Sizing 
You can control the your image’s size by changing the zone 
boundaries. As the zone increases or decreases, the image adjusts to 
fit the new dimensions. 
 
b.  Aligning 
You can align the image by pressing the left, center, or right alignment 
buttons on the lower tool bar in the Design Window.  
 
c. Rotating 
Once you’ve inserted an image on the Binderstrip™, you can rotate 
it by selecting Rotate CW (ClockWise) or Rotate CCW (Counter 
ClockWise) from the Format � Image menu.  Each rotates the 
image in 90° increments.  Keep in mind that as you rotate the image, 
its orientation changes.   

 
       3.  Deleting an Image 
       To remove an image, go to the Edit menu, and choose Clear Zone. 
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How To Make A Strip Like This 
(Or:  Using Bitmap Images to Get Different Styles in One Zone) 

This is an 
inserted image. 
Notice there 
are three fonts, 
three font sizes, 
and two styles 
in one zone! 

In this version of PowisPrint™ software, you can’t directly enter different fonts and styles in the same zone—i.e., 
you can’t have a zone that reads, “Happy friendly dog.”  But you can do this by using a zone for each word, 
or creating your own bitmap image.  Creating your own bitmap allows you to type your title exactly as you want it 
to look on your strip.  All you do is open a drawing program, type your title, save it as a bitmap, and then insert it 
on the strip as an image.  Let’s try. 
 
1.  Open a drawing program. (In Windows, go to the Start menu, then Accessories, and select Paint.) 
 
2.  Using the text tool, type your title text.  We typed, “ALIENS STOLE MY CAT! By Rita Pilleggity” and then 
formatted it. Notice that we used three different fonts, three font sizes, and two different styles.   
 
3.  Save it as a monochromatic bitmap image. (Under “Save as type,” select “Monochrome bitmap.”)  Remember 
where you’re saving it, so you can retrieve it. 
 
4.  Close Paint. 
 
5.  Open a new PowisPrint™Design Window. 
 
6.  Insert the bitmap image you just created.  If you’ve forgotten how to insert an image, here’s how: 
             a.  Go to Insert  � Image. 
             b.  Click the “Load Image” button. 
             c.  Navigate to the location where you saved your bitmap. 
             d.  Click “Open.” 
             e.  Once the system returns to the “Load Image” screen, click “OK.” 
 
7.  Format your strip as usual.  We added two more zones:  one with text (“neptune books”), and one with an 
image (a star).  Easy as pie! 
 
In future versions of PowisPrint™, you will be able to directly use different fonts and styles in one zone. 
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E.  Colors, Colors, Colors 
 
      These features help you visualize your strip by allowing you to see 

your title on 16 (!) different colored Binderstrips™, using four 
different foil colors.  

 
      1.  Strip Color 
      Click “Strip Color” to display your strip color options.  When you 

open this window, the currently selected strip color is highlighted. 
“Preview” displays each color as you click on it.  

 
      Choose the color you want.  Once you have selected your color, 

select “OK” to activate your selection; “Cancel” to exit without 
making changes.  

 
REMINDER:  The color of the printed Binderstrip™ is dictated by 
what color strip you feed into the PowisPrinter™.  Although you might 
have chosen a red strip in the Design Window, if you insert a purple 
strip, the printer will print on that purple strip.  
 
      2. Foil Color 
      The foil color is the text color on your strip. Click “Foil Color” to 

display your foil color options.  When you open this window, the 
currently selected foil color is highlighted. “Preview” displays each 
color as you click on it.  

 
      Choose the color you want.  Once you have selected your color, 

select “OK” to activate your selection; “Cancel” to exit without 
making changes.  

 
REMINDER:  What you choose here does not necessarily reflect 
what prints.  That depends on the foil cartridge you have in your 
printer.  If you have a gold cartridge in your PowisPrinter™, it will print 
gold titles, regardless of your Foil Color selection in the Design 
Window.  
       
F.  Book Thickness 
 
      Say you're designing a Binderstrip™ for a book.  Eventually you 

need to know your book's thickness, so your design fits your book.  
If you do know your book's thickness, you can adjust the design's 
thickness as appropriate.  If you don't know your book's thickness, 
don't worry.  As long as your binder is docked to the 
PowisPrinter™, PowisPrint™ software can update your design to 
match the book in the binder.  

 
NOTE: You can design titles for a wide range of book thicknesses:   
from 0.04 inches to 1.5 inches thick (using standard copy paper, this 
translates to between 10 and 375 sheets*). 
  
      1.  If You Know Your Book’s Thickness 
      If you know your book’s thickness, or you want to see how your  

* If the document you plan to bind contains 
something other than standard, 20-pound-
bond paper, you may want to change the 
“Pages Per Inch” setting in the Preferences 
Menu (see Chapter 4, page 57).  If you do 
not want to make this change, simply use 
the “Thickness” measurement as your guide, 
instead of “Sheets.”  
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      design looks at different thicknesses, you can modify your design, 
using these great Design Window tools:   

 
a.  Sheets 
This box displays how many sheets of paper the book you're  
designing for contains.  You can enter the number of sheets 
directly in this box, or use the up and down arrows to change 
the value. For example, if your book has 50 pages, enter 50 in 
the Sheets box.  As you alter the number of Sheets, the Book 
Thickness box also changes. The Strip Width Indicator Box 
displays the correct width strip.   
 
b.  Book Thickness 
This box displays the book thickness in inches or millimeters.  
You can enter a new number directly in this box, or use the 
up and down arrows to change the value.  For instance, if your 
book measures 1.5”, enter 1.5” in the Book Thickness box.  
Note that as you alter the Book Thickness, the Sheets box 
also changes.  The Strip Width Indicator Box displays the 
correct width strip.   
 
c.  Ask Button 
Pressing the Ask button in the Design Window automatically 
updates your title design to the thickness of the book in the 
binder.  When your PowisPrinter™ is properly docked to a 
Fastback®, insert the book you want to bind and press the 
green Bind button.  Then, in the Design Window, press the 
Ask button.  The software communicates with the Fastback®, 
then matches the title’s thickness to the book in the binder.  
Handy, huh?  

              
NOTE: You cannot change the Strip Width Indicator Box directly. 
 
      2.  If You Don’t Know Your Book’s Thickness 
      If you don't know your book thickness, you can either take a guess 

at how thick it is (and hope for the best), or dock your printer to a 
Fastback®, and use the Ask buttons.  If you want, you can even 
wait until you're ready to print to enter this information.  Here's 
how: 

 
a.  Design your title at any thickness.  
 
b.  When you’re ready to bind, insert your book in the binder 
(your binder must be docked to a PowisPrinter™). Press the 
green Bind button. 
 
c.  Open the Print Window.  If your title design’s thickness 
does not match the book in the binder, the Status Boxes 
reflect the conflict.  A “Book thickness mismatch” message 
appears in the “Other” window of the Fastback® Status Box, 
prompting you to correct the mismatch by pressing the Ask & 
Update button.  You can either: 

 
             • Press the Ask & Update button, which updates your design 

       according to the thickness of the book in the binder; then  
             returns to the Design Window so you can preview your  
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design at the new thickness.  To reenter the Print Window, 
select “Print” again.  Now the information in the Design 
Window and Fastback® boxes match exactly.  
                                                                              
              
                                       OR 
 
• Choose not to correct the book thickness mismatch.  You 
will not be allowed to press the “Print & Bind” button—the  
button will be disabled.  But you can press “Print,” and the 
printer will print the title exactly as you designed it, ignoring 
the book in the binder 
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A.  The Print Window 
 
      When you select “Print” from the file menu, the Print Window 

opens.  ThePrint Window display is divided into five buttons (the 
Print Commands) and four boxes (the Status Boxes).  

       
      1.  The Print Commands 
 

 a.  Print  
Prints the title in the active Design Window, then ejects the 
printed strip from the PowisPrinter™ Feed Exit (below the 
purple strip guide).  Pressing “Print” successively in the same 
Print Window allows you to repeatedly print the current 
design.  
 
 b.  Bind Only 
When docked to a Fastback® binder, the 
PowisPrinter™accepts a strip and without printing, sends the 
strip to the binder. 
 
 c.  Print & Bind 
When docked to a Fastback® binder, the PowisPrinter™ 
prints the title in the active Design Window and 
automatically feeds the printed strip to the binder, which 
then automatically binds the book.  Pressing “Print & Bind” 
successively in the same Print Window allows you to 
repeatedly print, then bind, the current design.  
              
d.  Repeat 
When docked to a Fastback®, you can use this feature to 
title and bind a series of the same-thickness books (see 
page54 for more details). 
                           
 e.  Eject  
Ejects the strip out the PowisPrinter™ Feed Exit (below the 
purple strip guide). 

 
      2.  The Status Boxes 
 

 a.  Design Window Information Box.  Displays the book 
thickness and strip width you have chosen in the active 
Design Window. 
 
 b.  Fastback® Information Box.  When a Fastback® is 
docked to the printer, this box indicates information the 
Fastback® has sensed. If you put a book in the binder, the 
Fastback® detects the book thickness, and determines 
which width Binderstrip™ to use. The software displays this 
data here. If it does not match the Design Window 
Information, you can press Ask & Update to update your 
design according to the thickness of the book in the binder.  
If your printer is not docked to a Fastback® binder, the 
Fastback® box will be empty. 

              
       (Continued on page 52)  

Tip: 
                   If you’d like to see your   
                title design magnified, use the        
              Zoom Mode tool.  Click on the  
           magnifying glass, and then click on the          
         strip until it reaches the desired  
        magnification.  Use the left mouse key to   
       increase magnification; the right mouse 
      key to decrease magnification.  Press the   
      “Display Entire View” key to reset the 
       image to 100%.  

P R I N T I N G  IV
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The Thrilling Print Window 

1      OK Button.  Click this after the printer has printed and ejected your title, or when you are ready to exit the Print Window.   
 
2      Printer Status Box. Indicates what’s happening in the PowisPrinter™.  As the PowisPrinter™ performs each function (getting online, 

recognizing strip, receiving title, printing), the corresponding box illuminates.  Any other information appears in the “Other” message box.  
 
3      Design Window Information Box.  Displays the book thickness and strip width you have chosen in the Design Window.  
 
4      Fastback® Information Box.  When a Fastback® is docked to the printer, this box indicates information the Fastback® has sensed.  If 

you put a book in the binder, the Fastback® detects the book thickness, and determines which width Binderstrip™ to use.  The 
software displays this data here. 

 
5      Print Button.  Pressing this button prints the title you’ve just created, and ejects the strip from the PowisPrinter™ Feed Exit. 
 
6      Bind Only Button.  When docked to a a Fastback® binder, you can use this button when you want to insert a Binderstrip™ into the 

printer, and, without printing, send the strip straight to the Fastback® for binding.   
 
7      Print & Bind Button.  Use this option when you are docked to a Fastback® binder.  If you press Print & Bind, the PowisPrinter™ prints 

your design on a Binderstrip™, then sends the strip directly to the Fastback® for binding.  
 
8      Ask & Update Button.  Press this if you’d like the software to update your design according to the thickness of the book in the binder.  

After you press Ask & Update, the software returns to the Design Window, so you can see how your strip looks at the  new thickness.  
 
9      Repeat Button.  When docked to a Fastback®, use this feature to title and bind a series of the same thickness books.  
 
10    Eject Button.  Ejects the Binderstrip™ from the PowisPrinter™ Feed Exit.  
 
11    Fastback® Status Box.  Indicates what’s happening in the Fastback® binder.  Each box illuminates as the Fastback® performs the 

corresponding function.  For example, when the Fastback® is docked, the Docked box will be lit.  Any other information appears in the 
“Other” message box.  
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c.  The PowisPrinter™ Status Box.  Indicates what’s happening 
in the PowisPrinter™.  As the PowisPrinter™ performs each 
function, the corresponding box illuminates.  Any other 
information appears in the “Other” box. 
 
d.  The Fastback® Binder Status Box.  Indicates what’s 
happening in the Fastback® binder.  Each box illuminates as 
the Fastback® performs the corresponding function.  For 
example, when the Fastback® is docked, the Docked box will 
be lit. Any other information appears in the “Other” message 
box. 

 
B.   How To Print Your Titles 
 
      1.  How to Print a Title Only 
 

a.  Create your title. 
 
b.  Go to the File menu and select Print, or press the small 
printer icon in the Design Window. 
 
c.  When the Print Window opens, wait while the PC 
establishes a communication link with the PowisPrinter™.  
When the “Please wait…” message disappears, look in the 
Printer Status box.  The lights next to “Online” and “Ready” 
will be green.  
 
d.  Press “Print.” 
 
e.  A message appears at the top of the Print Window, telling 
you the which width strip to insert. 
 
f.  Insert the appropriate width strip, adhesive side up. 
 
g.  Watch the lights in the PowisPrinter™ Status Box to see 
the status of the print job.  When the printer has printed your 
strip, it ejects the strip from the PowisPrinter™ Feed Exit, and 
the Print Window displays, “Printing Completed.”   
 
h.  If you’d like to print the same title again, press “Print” again.  
Repeat printings of a title (within the same Print Window) are 
very quick.  Since the printer does not have to receive any 
new data, it’s ready to print as soon as you insert a strip.  
 
i.  Press “OK” to exit the Print Window. 
 
A word about the OK button in the Print Window 
If you close the Print Window while the printer is still printing, 
the printer will not eject your title upon completion.  Just go 
back to the Print Window (by selecting Print from the File 
menu), and press “Eject.”  The printer now ejects your 
completed strip. 
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      2.  How to Print a Title and Bind in One Incredible Step (available 
only when docked to a binder)  

 
a.  First make sure your Fastback® is properly docked to the 
PowisPrinter™. 
 
b.  Insert the book you want to bind into the Fastback®. 
 
c.  Press the green Bind button on your Fastback®. 
 
d.  Now go to your PC, and create your title. 
 
e.  When ready, go to the File menu and select Print, or press 
the small print icon in the Design Window. 
 
f.  In the Print Window, press “Print & Bind.”   
                                        
g.  Compare the Design Window information to that in the 
Fastback® Information box.  If the book in the binder is not 
the same thickness as the title you’ve designed, the amber light 
in the Fastback® Status box illuminates.  Just below it, a 
message appears in the “Other” box: “Book thickness 
mismatch. Press Ask & Update button, Select Print again.” 
 
             If you press the Ask & Update button in the 
Fastback® box, the PC automatically updates your design to 
match the book in the binder.  It then returns to the Design 
Window so you can see your updated strip design.  To return 
to the Print Window, select Print from the File menu.  The 
Design Window and Fastback® Information boxes should 
now match, so you can press “Print & Bind.” 
 
(If you do not wish to match your title design to the thickness 
of the book in the binder, ignore the mismatch message and 
press “Print.”  You won’t be able to print and bind in one step, 
but the printer will print the title design according to the 
specifications in the Design Window, ignoring the thickness of 
the book in the binder.)      
 
h.  When prompted, insert the appropriate width strip into 
the PowisPrinter™, adhesive side up. 
 
i.  Watch the PowisPrinter™ Status box for the status of the 
print job. When the printing has completed, the printer sends 
the strip to the binder.  The Fastback® Status box now 
reflects its activity. 
 
j.  Watch your Fastback® to see when the job has completed. 
 
k.  Press “OK” to exit the Print Window. (Note:  You don’t 
have to wait until the binding is complete to exit the Print 
Window.  You may close the Print Window as soon as the 
PowisPrinter™ has ejected the strip.) 
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      If the PowisPrint™ software does not detect the Fastback® in the 
Design or Print Window, make sure the PowisPrinter™ and 
       Fastback® are properly aligned.  

 
      3.  How to Bind Only (available only when docked to a binder)  
 
      Use this feature if you’ve printed a title, reviewed it, and now 

simply want to bind your document with that strip. (If you prefer, 
you can always bind the old-fashioned way, and feed your strip 
directly to the binder.) 

 
\a.  First make sure your Fastback® is properly docked to the 
PowisPrinter™. 
 
b.  Insert the book you want to bind into the Fastback®, and 
press the green Bind button.  
 
c.  Now go to your PC, and open a Design Window.  Type 
something on the Design Window Binderstrip™ (it doesn’t 
matter what you type—this is necessary only to open the 
Print Window). Now press “Ask” to update the thickness to 
the book in the binder.  
 
d.  Select Print from the File menu. 
 
e.  Press “Bind Only.” 
 
f.  Insert your strip in the PowisPrinter™, adhesive side up.  
(Note there is no prompt to insert your strip.) 
 
g.  Press “Bind Only” again.   

       
      The printer now forwards the strip to the Fastback®, and the 

binder binds your document with the strip you inserted.  
 
C.  Your Friend the Repeat Button 
 
      The Repeat Button allows you to title and bind a series of the 

same-thickness books. For example, if you have twenty copies of a 
manual to title and bind, use REPEAT.  It makes the binding job 
lots easier, and is quick, quick, quick.  Keep in mind that the 
REPEAT button is for multiple print-and-bind jobs only.  If you 
want to print and bind a single document, use PRINT & BIND; if 
you want to print many strips of the same title, use PRINT.  But if 
you’ve got seven pamphlets to print and bind, REPEAT’s the 
button for you.  

 
      Here’s how to take advantage of this nifty feature:  
 
      1.  First make sure the printer and binder are docked.   
 
      2.  Design your title. 
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      3.  Press the Print icon in the Design Window, or go to File      
Print. 

 
      4.  Put your first book in the binder, and press the green Bind 

button.  You must have a clamped book in the binder to activate 
REPEAT. 

 
      5.  In the computer’s Print Window, make sure the Design 

Window and the Fastback® Information boxes match.  If they 
don’t, press Ask & Update to update your design to match the 
book in the binder.  Once you have reviewed your updated title in 
the Design Window, press the Print icon to return to the Print 
Window.  

 
      6.  In the Print Window, press REPEAT.  (If REPEAT is grayed out, 

make sure the binder and printer are properly aligned.) 
 
      7.   A box appears (Figure 3), asking how many times you want to 

repeat the print-and-bind job.  Enter a number directly in the box, 
or use the up and down arrow keys to change it.  You can repeat 
a job up to 200 times. 

 
      8.  Press OK. 
 
      9.  When prompted, insert a strip into the printer. 
 
      10.  The printer prints the strip, then forwards it to the binder for 

binding. Once the binder has accepted the strip, insert another 
strip into the printer.   

                           
      11.  While your next strip is printing, remove the bound book 

from the binder and place it in a cooling rack. 
       
      12.  Insert your next book into the binder, and press the green 

Bind button to clamp it.  
 
      13.  The printer now forwards the next strip to the binder.  The 

printer always makes sure the binder is ready before forwarding a 
printed strip.  Say you inserted a strip, and it printed, but you 
haven’t removed the last bound book from the binder.  The 
printer will wait until you remove the completed book and clamp 
the new one before sending the strip to the binder.  This prevents 
jammed strips, books with multiple strips, and general chaos. 

 
      Repeat this process until you have finished your entire job. If you 

lose track of how many strips you’ve printed, check the top of the 
Print Window.  It tells you how many strips remain, and lets you 
know when the job is finished. 

 
REMINDER:  REPEAT only works on same-thickness books.  During 
a Repeat cycle, if you put a book in the binder of a significantly different 
thickness, the Repeat cycle ends and a message appears on your 
computer screen.  This safety feature prevents errors, and requires you 
to restart REPEAT to continue with the correct book. 
 

D I A G R A M A /S C HÉ M A / F I G U RE  3 
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      You can change standard features such as the default strip width, 
measurement units, language, and the serial port number in 
Preferences.  To access these options (and more), go to the File 
menu, and select Preferences. 

 
 
A.   General  
 
      Default Strip Width 
      Each Design Window opens with a design strip at a default width.  

The factory setting is Narrow, but you may change it to Medium 
or Wide.  If you change the width, the Design Window will always 
open with the width you select here.  

 
 
      Printer Adjustment 
      The printer adjustment allows you to shift your text in relation to 

the Binderstrip™ center.  Using the up and down arrow keys, you 
can modify the text centering by hundredths of an inch.  If you're 
in Landscape orientation, a positive value shifts the text up from 
the center; a negative value shifts the text down from the center.  
If you're in Stacked or Portrait orientation, a positive value shifts 
the text right of the center; a negative value shifts the text left of 
the center.  

 
NOTE: Any printer adjustment you make affects all printing on every 
strip, until it is manually reset to zero.  This is true even if you close and 
re-open PowisPrint™.  
 
 
 
B.   Color 
 
      Zone Bars 
      You can jazz up your Display Window by changing the zone bar 

colors.  
 

Active Zone  
Choose from the displayed choices to change the active-zone 
bar color.  The factory setting is white. 
 
Inactive Zone 
Choose from the displayed choices to change the inactive-
zone bar color.  The factory setting is grey. 

       
 
      Design Window Background Color 
      Add more sparkle to your Design Window by changing the Design 

Window background color.  Simply click the rectangle to access 
the color palette. 

P R E F E R E N C E S  V 

P R E F E R E N C E S  
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C.   Advanced 
              
      Initial Zoom Setting      
      This feature controls the size of the book image in the Design 

Window.  You can input the percent of zoom you would like, 
from 0.5% to 1.00%.  The factory setting is 0.93%.  

 
      Pages Per Inch 
      The printer measures book thickness by inches or millimeters.  To 

translate number of sheets, the printer must have a conversion 
rate. Depending on the thickness of your paper, this conversion 
rate can vary.  For example, there will be fewer sheets of thick 
paper than thin paper in an inch. 

 
      The factory setting—250 pages per inch—is based on standard, 

20-pound bond paper. If you are using different paper, and also 
using the “Sheets” feature to measure your book’s thickness, you 
may want to change this default. If you don’t, the printer will 
calibrate the appropriate width strip for 20-pound bond paper, and 
you will end up with strips that do not fit your documents.   

 
      Keep in mind that if you are using the “Thickness” feature to 

measure your books, or if you press the “Ask” button to update 
your design’s thickness, you do not need to worry about changing 
this setting.  

 
D.   Serial Port 
 
      COM Port Number 
      Choose between 1 and 4, depending on which port you connect 

the PowisPrinter™-PC connector cable to.  The default setting is 1.  
(See Chapter 1, “Installing the Software,” page 37, for more 
information on choosing ports.) 

 
E.   Regional Settings 
 
      Here you can set the default units, language, and orientation you 

would like PowisPrint™ to use (see Figure 4 on next page).  
Before changing any of these regional settings, you must close all 
open Design Windows. 

                           
      Language 
      Select the language by clicking the corresponding radial button. 
 
      Note that if you change the language from English, the 

measurement units and orientation automatically switch to the 
European settings. For example, if you select “French” as your 
language, PowisPrint™ switches to millimeters and the European 
text orientation.  If, however, you would like to work with a 
European language but still use inches or the US text orientation, 
simply click the appropriate button.  

P R E F E R E N C E S  



P O W I S P R I N T E R �   M O D E L  3 1  U S E R ’ S  M A N U A L  58 

      Unit of Measure 
      Click the respective radial key to choose inches or millimeters.   
 
 
      Title Orientation 
      This setting allows you to change the landscape text  
      orientation from US/Canadian to European style.  Changing this 

simply rotates any landscape text 180°. Note the difference 
between the text on the two book images—the landscape text is 
inverted.  

 
      To select an orientation, click a book image.  

D I A G R A M A /S C HÉ M A / F I G U RE  4 



P O W I S P R I N T E R �   M O D E L  3 1  U S E R ’ S  M A N U A L  

TAKING PRINTING  
 
TO THE 21ST  
 
CENTURY... 




